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Introduction 

The information in this document contains late breaking changes, additions and solved problems for 
WizFactory 3.0 products: Wizcon 8.0 for Windows and Internet and WizPLC. 

What’s New in Wizcon for Windows and Internet 8.0 

Listed below are some of the new or improved features in Wizcon 8.0 Service Pack:  

�       New / Changed Modules 
�             User Management 
�             Advanced Alarm Management 
�             Users Timetable 
�             Alarm Filters Manager 
�             Zone Navigators 
�             Printers 
�             Printer Targets 

�       Alarm Features 
�                Alarm Hierarchy 
�                Alarms Inhibition 
�                Alarm Delay 
�                Comments on Alarm 
�                Alarm Help in HTML format 
�                System Alarms 
�                Alarms definition for remote tags 
�                WAV files for Alarm Popup Buzz 

�       Events Summary 

New window design and functionalities 
 



�       Tag Features 
�                System Tags 
�                Lock Tag 

�       Image Features 
�                Fast Actions 
�                Zone Navigator 
�                Lock Objects 
�                Cluster Library 

�       Trend and Charts 
�                Trend on a bit of a tag 

�       Database Connectivity 

�                Open database connectivity 

�       Wizcon VPIs 
�                Support up to 32 VPIs 

What’s New in WizPLC 2.2 

�       WizPLC 2.2 integration in Wizcon Studio 
�                Integrating WizPLC  
�                WizPLC new / modified features 

  
  

 



New User Management System  

Wizcon 8.0 is enhanced with a new, advanced and easy to use User Management system. 

The User Management system enables you to manage all the users of an application both locally 
and remotely. 

The User Management provides full backwards compatibility, and imports groups created in 
previous versions to the new User Management system.  

In addition to the Group and User definitions, you can also define Teams, which are built of users 
who belong to the same group. This management methodology allows you to easily schedule 
groups, teams and individual users to various tasks. 

The User/Group management tool can be accessed from the Wizcon studio quick access bar. In 
addition, in the All Containers section of the Wizcon studio, the User Management icon was 
added under the tree root. You can view the list of defined users and the list of defined groups in 
the studio control panel. You can access a user/group (providing that you are an authorized user) 
and modify its parameters. 

By default, the User Management contains one group named Administrators. Users in this group 
are authorized to modify users properties (including name and password); however, this group 
name cannot be modified nor deleted. A user who belongs to this group cannot exclude himself 
from the group. 

Note:  If you have different applications installed on different stations, make sure each 
application has its own unique users and groups. Users with the same names defined 
in different applications will be able to share undesirable data. 

 



Defining Users / Groups 

To define a new User / Group, click the User Management icon on the Wizcon Quick Access Bar, 
the Users/Groups Management dialog box opens: 

 

The Users/Groups Management window contains two tabs: A Users tab, where all the users are 
listed; and a Groups tab where all the Groups are listed.  

Click the New button to display the New User dialog box where you can define a new user. In the 
Groups page, click the New button to open the New Group dialog box where you can define a 
new group. 

User Definition Components 

A user definition is comprised of the following components: 

�       General parameters  
User unique name, brief description, password, layout association (optional) and functional 
permissions (changing password, general information or Web access). 

�       Group association 
Selecting the group(s) the user is a member of, and defining whether he is the administrator 
of the associated group(s). A user defined as the group administrator is authorized to add 
users to his group, or remove users from his group. 

�       Advanced Alarm Management parameters 
In the Messenger tab, you can select the dynamic communication methods the user can be 
targeted by. These include message transmissions via SMS, e-mail, Fax, remote printers or 
even a voice message. The selected communication method will be activated if the user was 
added to a group or team configured to be the recipient of an alarm condition. The user can 
also be assigned with a backup user for these purposes. 

�       User additional information 
In the Information tab you can add the user’s address, PIN code and comments. 

Group Definition Attributes 

A group definition is comprised of the following components: 

�       General parameters 
A group general parameters include the group’s unique name and the group’s description. In 
the General tab you also define whether the group is an Alarm group. 



�       Users association 
In the Users tab you select the users who belong to this group. You can also define which 
user is the group’s administrator. 

Team Definition Attributes 

A team is a sub-group containing one or more users that can be scheduled using Wizcon Users 
Timetable. Each team is assigned with a unique color thus enabling you to easily view the team’s 
schedules on the timetable. 

When an alarm occurs, it is sent to the group authorized to receive the alarm; the group directs 
the alarm to the team according to the Users Timetable settings. 

A team can be defined from the Users/Groups Management dialog window, accessed form the 
Wizcon quick access bar. 

To define a team 

�       Select the group in which you want to create a team. 

�       Click the Teams button and type the team name in the New team name field. 

�       Click the New button to add the team to the list. 

To add users to a team 

�       Double click the team on the list. 
The Team Members dialog box opens. 

�       Select the group members you want to include in this team and click the Add button to add 
them to the team you created. 

  

Advanced Alarm Management 

Wizcon 8.0 Advanced Alarm Management (AAM) uses a multi-service communication platform to 
provide alarm transmission over various communication channels, including SMS, e-mail, fax and 
even vocal messages.  

The Advanced Alarm Management is comprised of two design mode components: AAM 
Channels and AAM Pager Services; and a run-time component: Advanced Alarm Viewer. 

To enable the AAM module, select the Advanced Alarm Management tab in the Wizcon Station 
Properties, select the Enable Advanced Alarm Management checkbox and restart Wizcon. 

To enter the Advanced Alarm Management window click the Advanced Alarm Management icon 
on Wizcon quick access bar. 

 

The Advanced Alarm Management Channels 



The AAM Channels setup enables you to define and configure the communication lines used by 
Wizcon AAM.  

In the Channels dialog box you select the COM ports of your computer through which a selected 
modem will communicate. 

Basically, the Advanced Alarm Management offers two types of communication lines:  

�       Hayes Modem – The communication goes through the telephone network and uses a 
modem of type Hayes. 

�       Direct – The communication is direct (printer connected to the port, etc.). 

Note   The channel setup is not necessary if you want to send emails directly through  an 
SMTP server 

 



The Advanced Alarm Management Pager Services 

The AAM Pager Services enables sending messages to a user destination using various media 
types: bip, paging system, fax, terminal or printer, e-mail, etc. 

When a request to send a message to a user is executed, the Pager service searches for a port 
compatible with the message system to use, initializes this port with the appropriate parameters 
and then starts calling to the messaging system destination.  

In the Paging Service Setup dialog box you modify the installed driver, or add new ones. You can 
also define the number of re-tries calls, in case a call fails and the timeout between each retry. 

The Advanced Alarm Viewer 

The Advanced Alarm Management Viewer helps you to view the status of the AAM messages. 
The messages display the status of each communication intersection (“good” or “bad”), an ID 
provided automatically by the system, the name of the message recipient, and additional 
information. 

Users Timetable 

Wizcon 8.0 provides you a new and easy way to schedule your application’s teams. Using the 
Users Timetable you can select a team and schedule it on a calendar environment which offers 
you three different views: Weekly schedule, Daily schedule and Special Days schedule. Each 
team has its own colors, which makes it easier to manage this timetable. 

Zone Navigators 

Wizcon version 8.0 is enhanced with a new, global zone navigation window that enables you to 
quickly and efficiently navigate through a list of zones defined in your application’s various image 
objects.  

Using the Zone Navigator window you can define a number of navigators each of which can 
contain a number of zones from one or more different image files. 

The Zone Navigator can be applied on images through triggers of type Button and Action, or by 
configuring a macro of type Action using the ZoneNavigation action macro. 

To indicate a zone's status, you can attach a digital tag representing the zone's status to each 
zone navigator. If the tag value is set to 1 the Zone Navigator status will be BAD, if set to 0 the 
Zone Navigator status will be GOOD. You can also define the color in which zones defined with a 
control tag that has BAD status will be displayed in the run-time Zone Navigator window. 

The multi-image zone navigator can be activated from the Wizcon Studio control panel, or from 
the Wizcon Studio Design menu. At run-time, it can be activated form the image using a button or 
action trigger. 

The Zone Navigator window lists all the zone navigators: 



 

Adding a zone navigator 

To add a new zone navigator, click the New button, the New Zone Navigator dialog box is 
displayed: 

 

Type a name for the zone navigator and a description. Select the Always on top checkbox to 
display the zone navigator window on top of all other windows. Type the time interval after which 
the zone navigator will disappear in the Close after box. Click the Add button to select the 
various images zones you want to include in this zone navigator: 

Alarm Filters Manager  

The Alarm Filter functionality was expanded and is now used not only for filtering alarms, but also 
for the Events Summary and the Targets definition. The Alarm Filters can be accessed from the 
Wizcon Application Studio control panel by double clicking the Alarm Filters icon, or by selecting 



Alarm filters from the Design menu. The Alarm filters window contains a list of all the filters you 
defined: 

 

Click the Add button to open the Filter Properties dialog box where you can define a new filter. 

The General tab is used to define the filter’s general information: name, description, zone, family, 
severity and class. 

 

In the Network tab you select the stations you want to filter: 



 

In the Counters tab you define counters for alarm start, acknowledge and end: 

 

Selecting alarm filters from Events Summary 

You can select any of the filters defined in the Alarm Filter manager, add them to the Events 
Summary to enable alarm filtering, and access the Filter Properties dialog box to modify these 
filters. 

Select Filters from the Settings menu of the Events Summary window to open the Select Filters 
dialog box: 



 

Selecting alarm filters from Targets 

You can select any of the filters defined in the Alarm Filter manager; add them to your Targets 
definition to enable alarm printing filtering and access the Filter Properties dialog box to modify 
these filters. 

Printers 

Enhanced printers specification dialog box is provided to enable you use advanced printing 
capabilities. Each printer added to your system can be set to print Reports, Alarms or both. 

 

In addition, you can define whether the alarm will be printed in a full page or whether only one 
alarm will be printed on each page; you can define orientation and font, and you can select which 
of the alarm properties will be printed. You can also set different colors both to text and 
background. 

  



Printer Targets 

A printer target is a collection of pre-defined filters and printers specifying the conditions under 
which a target printer will be activated. 

A target is a collection of pre-defined filters and printers specifying the conditions under which a 
target printer will be activated. 

Adding a Target 

A target definition is comprised of a user-defined name and description and a selection of printers 
and filters. 

 

When clicking the Select Filters button, a list containing all existing filters is displayed, enabling 
you to select the filters you wish to include in the target. 

When clicking the Select Printers button, a list containing all defined printers is displayed, 
enabling you to select the printers you wish to include in the target 

Activating a Target Printer 

The targets you define are displayed in the Printer Targets dialog box: 

You activate a target by clicking the Load button. A check mark next to the target indicates that 
this target is loaded. You disable a target by clicking the Unload button. 

 



Alarm Features 

Wizcon 8.0 offers a better, powerful alarm management system. Some of the new features were 
designed to enhance Wizcon performance in building automation applications. 

Alarm Hierarchy 

Replacing Wizcon traditional alarm flat structure, alarms can now be displayed in a hierarchical 
tree in which an alarm has a parent, child and sibling relations with other alarms.  

Under Alarm objects you can now create, in addition to Alarms, Levels. To each level you can 
attach an alarm. The Alarm tree might look as follows: 

 

The above tree demonstrates how easily you can map a geographical structure and define alarms 
accordingly. 

A parent level definition overrides its child definitions, if the parent level was defined to perform 
inclusive modifications. 

Alarms Inhibition 

The Alarm Inhibit feature enables you to “lock” an alarm periodically. This is mostly useful when 
you wish to de-activate an alarm temporarily and then turn it active again.  

At run time, you can inhibit alarms from the Events Summary. Selecting the Inhibit option from the 
Events Summary window opens the Internet Explorer, where you can impose the Inhibit option on 
alarm levels. 

Alarm Delay 

The alarm delay property enables you to define a delay time interval during which alarms will not 
be generated according to the selected reset type: 

Condition is false – selecting this option, each time the alarm condition is false within the time 
delay, alarms will not be generated. 

Delay time ends – If the alarm condition is true at the end of the defined time delay, alarms will 
be generated 

Never – the delay feature will not be imposed. 

Comments on Alarm 

Wizcon 8.0 provides the operator with a simple tool enabling him to add his own notes or 
comments to Wizcon Alarms.  

The notes can be added to alarms that were targeted to file (Record to file was checked in the 
Alarm Definition dialog box). The operator can access the User Comments dialog box (if 
authorized to do so) from the Events Summary, by simply right clicking an alarm and selecting 
User Comments from the popup menu. The User Comments dialog box is divided into two parts: 
The upper part of the window displays previous notes entered by the operator(s), each message 



is date and time stamped and states the user name who wrote the comment (this information is 
entered automatically); the lower part of the window is a multi-line text based editor. 

Alarm Help in HTML format 

This new feature enables the user to monitor the alarm help file at run-time in a browser-like 
window. 

System Alarms 

New built-in alarms indicating application status were added. 0 

5 types of system alarms were added: Hot Backup alarm, Network Communication Error alarm, 
VPI Communication Error alarm, User Login alarm and WIL Diskfull alarm. 

These alarms are available on the Alarm Properties dialog box. 

Alarms Definition for Remote Tags 

This Wizcon version enables you to define and acknowledge alarms based on a remote station 
tag. 

WAV Files for Alarm Popup Buzz 

You can select a WAV file to be displayed instead of the traditional Wizcon Popup Buzz sound.  

Additional Features 

�       Field length: Alarm text field can now contain up to 253 characters; alarm family can be up to 
64 characters. 

�       Visual Basic notation is supported in the Alarm Expression. However, you can use previous 
versions notation as well. 

Tag Features 

System Tags 

Wizcon 8.0 is enhanced with system tags – pre-defined, built-in tags that provide system status 
information. 

To add system tags to your Wizcon application, select Add System Tags from the Tools menu. 
Note that system tags can be added to your application only once and cannot be removed. 
Adding system tags is also available when first starting an application. 

After added a new icon and sub-folder is added to the All Container tree under Tags called 
System Tags, and all the system tags are displayed in a list. 

Lock Tag 

This new feature enables you to lock tags for a predefined time. A new tab was added to the Tag 
Definition dialog box, called Lock Tag, where you set the lock parameters: 



 

You can define the tag value when locked, which means that the tag remains with this value until 
lock expires. In the Time Definition section you can select the Never expire option to keep the tag 
permanently locked, or define the tag expiration date and time. You can also define a status tag 
(a digital tag) to indicate the locked tag status. 

You can define a trigger using the LockTagsValues Fast Action to display at run-time a list of all 
the tags, which were defined with the Lock Tag feature and change lock tag status and values.  

  

Image Features 

Fast Actions 

Wizocn 8.0 offers a new type of triggers called Fast Actions. These actions are predefined, built-in 
macros that enable you to easily trigger routine operations. Among the available actions are: 
load / close window, load / close image, load / close chart, load / close Events Summary. 

Zone Navigator 

The new navigation option, that enables navigating through the various application’s images 
zones (for details refer to Zone Navigators, on page 7), is available where zones are selectable in 
the image definition (you can select either Zone or Zone Navigator). 

Lock objects  

You can lock / unlock an object in your image file to prevent object modification or undesirable 
removal. 

Cluster Library 

When adding a new library, you can choose whether this library will be saved to the Wizcon 
global Cluster library, thus enabling this library for other applications usage as well. 

 



New Event Summary Window 

The Events Summary window was re-designed to provide you with a full Windows look and feel. 
The new Events Summary window provides customization of the window’s columns and colors. 

 

New functionalities were added to the Events Summary, such as User Comments, Goto zone and 
Alarm Inhibition. 

Trend on a Bit of Tag 

A new functionality was added to both chart (Wizcon for Windows) and trend (Wizcon for Internet) 
definitions enabling you to display chart / trend on a tag’s bit.  

The Chart dialog box was modified as follows: 

  

To enable displaying the tag’s bit, select the Choose a bit checkbox and then scroll to select the 
bit number (0 to 15). 

The Trend dialog box was changed as follows: 



 

To enable displaying the tag’s bit, select the Display bit number checkbox and then scroll to select 
the bit number (0 to 15). 

You can use only signed 16 or 32 and unsigned 16 or 32 tags 

Open Database Connectivity 

This Wizcon version provides an open, standard database (Microsoft Access) that enables you to 
easily access all your application’s database files and modify data in those files: 

 

You can, for example open the WIZGATES database and modify or add tags according to your 
needs. 

Communication Drivers 

This Wizcon version supports up to 32 communication drivers. 

WizPLC 2.2 

A new powerful version of WizPLC is released enabling you to use a new programming language, 
called CFC (Continuous Flow Chart) for developing WizPLC applications. This version is fully 
integrated in the Wizcon Studio and WizPLC parameters values can be monitored using Wizcon 
system tags. 

�       A special system tag WIZSYS_WIZPLCSTATE enables operating WizPLC from the 



Wizcon studio and monitoring WizPLC status. 

�       New Function Block BlockComAccess enables WizPLC operation with up to 16 
Communication ports. 

�       The Function Block WgetGateValEx was added to extend an existing function block 
WgetGateVal, thus enabling the user to select whether to write to a database or directly 
to a PLC. 

�       WizPLC Master Backup mechanism performance was improved. 

Miscellaneous 

Microsoft MDAC (Database Access Components) 

During the installation the Microsoft MDAC 2.6 setup process is initiated. This will install the 
MDAC, including the XML parser components, to your system to support Wizcon 8.0 open 
database connectivity. 

Application Notes 

Internet Application on Windows NT 

Using Wizcon Alarm Inhibit feature on a Web application using Windows NT option pack 4.0, IIS 
4.0 configured with a Personal Web Server (PWS), requires the following pre-configurations: 

If clicking the Inhibit option in the Events Summary generates the message: “Only InProc server 
components should be used. If you want to use LocalServer components, you must set the 
AspAllowOutOfProcComponents metabase setting. Please consult the help file for important 
considerations.” do the following: 

�       In the command line type: D:\WizFactory\Wizcon\Bin\IISConfig.exe 2, where 
D:\WizFactory\Wizcon\Bin is the path of Wizcon Bin folder. 

Note: Before running the above command, make sure that your IUser _MachineName and 
IWAM_MachineName are members of the Administrators group. If not, open the User 
Manager (from the Windosw NT Administrative Tools), add these users to the Administrators 
group and restart your computer. 

�       Restart your computer after running the command. 

If clicking the Inhibit option in the Events Summary generates the message: 

“Data is unavailable. Make sure that your Wizcon application is running!” do the following: 

�       Open the Internet Service Manager (located under: Start / Programs / Window NT 4.0 Option 
Pack / Microsoft Personal Web Server). 

�       Right click the virtual directory called “Docs” (this is the default name of your Wizcon Web 
application files folder) located under Default Web Site and select Properties from the popup 
menu. The following dialog box appears: 



       

�       Select the Run in separate memory space (isolated process) checkbox. 

�       Click the Apply button. 

Note: If you change the default name of the virtual directory, look for the name you gave this 
directory. 

Importing tag and alarms from previous versions applications 

When importing tags and alarms from previous versions applications the security of the imported 
items is set to Access All. 

Make sure you change the security of these items according to your new version application 
requirements. 

Event Summary menu authorization 

Wizcon 8.0 Event Summary is not backwards compatible with menu items authorization of the old annunciator 
files. Converting old files will grant all users with full authorization. Make sure you re-define the authorization 
of the event summary menu items after converting the old files. 

  

Solved Problems 

The following problems reported in previous Wizcon versions were solved in Wizcon version 8.0: 

�       The problem occurred when re-opening a graph reference dialog box was solved 
(SPR431). 

�       Unnecessary error messages written to the errors.rcp file when loading a recipe 
(SPR414). 

�       ToolKit components were not removed after uninstalling Wizcon (SPR416). 

�       Alarm is acknowledgment on the Web now displays the user name is in the event 
summary. (SPR409) 

�       When Exporting/Importing Alarms to/from CSV file the last field of the alarm definition 
was missing. (SPR401) 

�       A trend working in history mode no longer looses data. (SPR399) 

�       Chart and Report no longer use tag reset values (0) that caused wrong results. 
(SPR393) 



�       Wizcon session ended when adding or changing values of analog tags to a recipe in a 
recipe model that includes both analog and digital tags. (SPR392) 

�       The maximum number of tags in an HTML trend is 15, while the chart on which the trend 
is based allows 16. (SPR373) 

�       Deleting tags, which are used in the Grid, setup from a Chart will caused Wizcon to 
crash. (SPR358) 

�       Editing an Image with menu bar disabled causes ended the Wizcon session. (SPR350) 

�       Objects were not aligned properly in the image. (SPR342) 

�       When Windows and Wizcon crossed into daylight time (automatically), the logger 
stopped logging for an hour. (SPR340) 

�       Alarm object did not reflect the tag value. (SPR317) 

�       Alarm object definition was not saved to the ILS file. (SPR316) 

�       Problems using Dynamic Text Displays of the type Date were fixed. (SPR279) 

�       The PRINT$B command did not accept an analog tag appearing before a string tag. 
(SPR273) 

�       Tags, which were In Monitor, were not being updated in the first InMonitor session. 
(SPR243) 

�       Tag combo box in Chart-Grid Setup was too small. (SPR224) 

�       Charts that were created in maximum screen width (manually dragged) loosed the menu 
bar when loaded. (SPR219) 

�       Grouping objects with both dynamic and trigger definitions, you could not find the trigger 
associated tag using the Find option (available on the Edit menu). (SPR198) 

�       The number of characters that you could enter in the Family Prefix field in the Events 
Summaries and the Events Summary Profiles was not equal. (SPR363) 

�       Error caused when deleting a Tag used by a Trigger and then adding a Tag with the 
same name (SPR360) 

�       Trying to close the Alarm Definition window after updating an alarm definition took a long 
time. (SPR349) 

�       Cluster object disappeared from the browser when rotated. (SPR338) 

�       Wizcon installation disabled some network commands, such as PING, NET USE, HELP. 
(SPR318) 

�       Text in HTML documents changed its original size (height and width). (SPR295) 

�       TrueType fonts on buttons were abnormally much bigger on the HTML page. (SPR240) 

�       The spinner of a String tag width value in the definition could exceed 80. (SPR221) 

Known Issues 

The following issues are known to exist in Wizcon version 8.0: 

�       Events Summary menu items authorization is not fully backward compatible. 

�       When the image window is in “Always on Top” mode, the Dynamic Definition dialog box 
hides behind the image window. 

�       After saving an image file, it is recommended to wait between 5 to10 seconds before 
continue working. 

�       Avoid importing system tags. 

�       Conversion utilities ALS2DAT and GLS2DAT are no longer used. 

  


